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HP Service Manager 

for supported Windows® and UNIX® operating systems 

Release Notes 

Software version: 7.11/July 2009 

This document provides an overview of the changes made to HP Service Manager for the 7.11 release. It 
contains important information not included in the manuals or in online help. 

Documentation Updates 
In This Version 
Known Problems, Limitations, and Workarounds 
Installation Notes 
Verified Environments 
Local Language Support 
Support 
Legal Notices 

Documentation Updates 

The first page of this release notes document contains the following identifying information: 

 Version number, which indicates the software version.  

 Publish date, which changes each time the document is updated.  

To check for recent updates or to verify that you are using the most recent edition, visit the following URL: 

http://h20230.www2.hp.com/selfsolve/manuals  

This site requires that you register for an HP Passport and sign in. To register for an HP Passport ID, go to:  

http://h20229.www2.hp.com/passport-registration.html 

Or click the New users - please register link on the HP Passport log-in page. 

You will also receive updated or new editions if you subscribe to the appropriate product support service. 
Contact your HP sales representative for details. 

NOTE: To view files in PDF format (*.pdf), Adobe Reader must be installed on your system. To download 
Adobe Reader, go to the following web site:  
http://www.adobe.com/  



 2 

In This Version 

The following areas are new or improved in Service Manager. For a list of the SCR fixes included in this 
release, see Enhancements and Fixes.  

Applications Patch Manager 

The Applications Patch Manager enables you to keep your Service Manager applications up to date without 
doing a complete application upgrade. By adding incremental updates, you decrease the number of changes 
that that you need to reconcile on your next application upgrade. To get started using the Applications Patch 
Manager, see the Application Patch Manager Guide available on the online Help server. 

Crystal Reports changes 

Service Manager 7.11 includes an OEM install of Crystal Reports 2008, the desktop solution to run and 
develop crystal reports.  

 It's back and free of charge (included in the foundation user license).  

 We include sixteen re-factored operational reports aligned with Service Manager HP Service Manager 
7.10 Best Practices. 

HP Universal CMDB update 

Service Manager 7.11 includes UCMDB 8.02 (Service Manager HP Service Manager 7.10 shipped with 
UCMDB 7.5.2). 

 The UCMDB install is now part of the regular Service Manager installation.  

 Because of Asset Management Federation, the Actual State can now be extended to display more HP 
Asset Manager information. 

To get started using HP Universal CMDB, see the HP Universal CMDB to HP Service Manager Integration 
Guide. 

RCA 4.12 

Service Manager 7.11 includes Release Control Analysis 4.12. (HP Service Manager 7.10 shipped with 
Release Control Analysis 4.10.)  

Change Planners can access the Release Control Assessment tab from Service Manager Web client in order 
to perform more accurate planning and assessment. To get started with Release Control Analysis, refer to 
the documentation included with Release Control Analysis. 

Connect-IT 4.0 

Service Manager 7.11 includes Connect-IT 4.0. (HP Service Manager 7.10 shipped with Connect-It 3.9.1.) 

Connect-It 4.0 comes with Service Manager scenarios. To get started using Connect-It, refer to the 
documentation included with Connect-It. 
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Help Server update 

Service Manager 7.11 includes an updated Help Server. 

Web client performance improvements 

Service Manager 7.11 includes performance enhancements 

The Web client has been updated to reduce network traffic for initial javascript and image file download in 
order to speed performance on high latency networks.  

SCAuto 1.4 for HP Operations Manager 

Service Manager 7.11 includes SCAuto for HP Operations Manager. (HP Service Manager 7.10 shipped with 
SCAuto 1.4 for HP Operations Manager 1.31.) 

SCAuto 1.4 for Operations Manager provides support for HP Operations Manager’s Custom Message 
Attributes (CMA). 

To get started using SCAuto for Operations Manager, refer to the SCAuto_DVD_Contents.txt file on the 
SCAuto CD. 

Upgrades 

Service Manager 7.11 Upgrade works with HP Service Manager 7.11 client and server. 

 You can use the 7.11 RTE with the 7.00 and 7.10 applications, including the 7.11 patch.  

 If you are upgrading from Service Manager 6.2 using DB2, you no longer need to enlarge the user space 
for some tables as described in the Enlarge user space for affected tables section of the Service Manager 
Upgrade Guide for 7.10. 

 

HP Service Manager 7.11 includes fixes to the following areas.  

Change Management and Configuration Management 
Knowledge Management and Service Level Management 
Problem Management and Request Management 
Applications 
Documentation 
RTE 
Tailoring 
Web Client 
Windows Client 

Change Management and Configuration Management 

The following items (identified by Software Change Request number) are fixed in the current software release. 

SCR Problem Fix 

38545 When double-clicking on a line in the 
Software tab for a computer type 
Configuration Item (CI), you receive an error 
message that states “No links exist.” 

The details of the   application now display 
when a user double-clicks application.name in 
the Software tab for a computer type CI. 
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SCR Problem Fix 

40722 The HP Change Calendar Installation and 
Configuration Guide reference to 
“webapp_servername” should be corrected to 
“SC_servername.” 

Updated the HP Change Calendar Installation 
and Configuration Guide so that all references 
to “webapp_servername” have been changed to 
“SC_Application_servername.” 

42259 Cannot process alerts for Change 
Management Changes and Tasks whose 
‘Reset’ and ‘Recalc’ alert conditions are based 
on $L.file.save. 

Changed code so that $L.file.save can now be 
used in the reset and recalc conditions of 
Change phase records. 

42278 Planned start and end time values are not 
correct in the Change Calendar Installation 
and Configuration Guide. 

Add a new section to the Change Calendar 
Installation and Configuration Guide “Setting 
the language and time zone values” to get this 
information into the guide. 

42369 RTE parse function fails when parsing a 
string with double quotes. 

Code modified to allow users to add and delete 
CIs with quotation marks in the name. 

Knowledge Management and Service Level Management 

The following items (identified by Software Change Request number) are fixed in the current software release. 

SCR Problem Fix 

42113 An administrator is not a subject matter 
expert and should not be listed as a possible 
assignee in Knowledge Management (KM), 
unless he is in a kmgroup explicitly associated 
with a category and a profile that allows him 
to be an editor in a KM Document workflow. 
Users with the capability words KMAdmin or 
SysAdmin should be removed from the list of 
KM Change Queue assignees. 

When a user clicks on Knowledge 
Management > Change Queue, selects a 
change, and then clicks on the Assignee look-
up, the list of possible assignees no longer 
automatically includes all KMAdmins or 
SysAdmins. 

42445 When a record is updated by an SLA alert, the 
corresponding ‘To do’ record is not updated to 
reflect the change. 

Added a call to the trigger records specific to 
the To do table for the alert.process 
application, so that the To do records are 
updated even if the triggers are turned off. 

42596 In Knowledge Management, if one user has 
modified a Knowledge Management 
document, other users cannot edit it, save it, 
retire it, revert it, approve it externally or 
internally, or create a working copy for it. 
Instead, users receive a message that states 
the function is not available and that the 
requested resource is in use. 

Corrected code so that clicking Working Copy 
or Add Feedback display options no longer 
cause erratic behavior. 

Problem Management and Request Management 

The following items (identified by Software Change Request number) are fixed in the current software release. 
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SCR Problem Fix 

40840 When there are more than 100 assignment 
groups, trying to open a problem causes an 
error message. 

Fixed Format Control for root cause and 
known error, so that you there are no errors 
when you open a problem and there are more 
than 100 assignment groups. 

41029 Line items created from copying and opening 
from an existing ‘ordered’ line item inherit the 
‘gen.ord.li’ value of its clone. 

Line items created from copying and opening 
from an existing ‘ordered’ line item no longer 
inherit the ‘gen.ord.li’ value of its clone. 

41246 When setting queries to run in the RAD 
ocml.dates.lead.set for Request Management, 
they run very slow. 

Running queries on the panel 
setup.parent.query in the Request 
Management ocml.dates.lead.set now run 
more efficiently. 

42128 The sequencing and dependencies in Request 
Management are incorrect for phantoms that 
include a bundle that is dependent on a line 
item. 

Requests for phantom line items that include 
a bundle depending on a line item now have 
the correct sequencing and dependencies. 

42330 Selecting ‘Back’ on the Request Management 
line item category selection screen has no 
effect when there is only one active quote 
category and master category. Instead of 
being allowed to exit the screen, I am forced to 
remain on the current screen. 

Fixed so that you can now exit back to the 
Request Management menu. 

42467 Known error tasks are not accounted for by 
the ‘To do’ table. 

Known error tasks have been added to the ‘To 
do’ table. 

43132 An existing line item has incorrect target 
dates for its parent and group line items. 

Corrected code so that the long work schedule 
is taken into account when ordering and 
changing the target order of an existing line 
item. 

Tailoring 

The following items (identified by Software Change Request number) are fixed in the current software release. 

SCR Problem Fix 

39206 The Delete Line and Insert Line options in 
Format Control do not work correctly. 

Corrected code in Format Control 
calculations, so that the Delete Line and 
Insert Line options work for all forms. 

40833 A hanging lock occurs when a record that is 
being updated by the event scheduler is 
modified right before a lock is issued for the 
record. 

No more hanging locks occur or error 
messages displayed when a record that is 
being updated by the event scheduler is 
modified right before a lock is issued for the 
record. 

41333 Receive an error when exporting some records 
as a text file, using the CSV option. 

Fixed the RAD application that handles this 
functionality, so that all records now export 
properly as a text file when using the CSV 
option. 
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Applications 

The applications include shared components, base utilities, administration calendars, and common data for user roles. The 
following items (identified by Software Change Request number) are fixed in the current software release. 

SCR Problem Fix 

31512 When using a scheduled purge and the subject 
Format Control record saves a copy, the 
application ends abnormally. 

Fixed the error, so that the variable $file0 is 
initialized for background purges as it is for 
foreground purges. 

39933 Alerts do not get rebuilt correctly to 
accommodate those that have been 
rescheduled. 

Alerts are now properly rebuilt when there is 
a lock on the record being processed for 
rescheduled alerts. 

40193 The standard repeat interval checkboxes for 
schedule records all behave as monthly 
schedule records. 

Fixed the standard repeat interval 
checkboxes for quarterly, semi-annually, and 
annually schedule records. Also fixed the form 
associated with it, to make it more consistent. 

40747 Executing the ‘calendar.calc.date’ application 
causes the date format to be reset to the tzfile 
instead of the setting in either the Operator 
record or Company record. 

Executing the ‘calendar.calc.date’ application 
now correctly uses the date format from the 
Operator record, if defined, or the Company 
record. 

40953 The “Record in Table” validation rules defined 
inside the Service Catalog User Selections are 
not enforced. 

The “Record in Table” validation rules defined 
inside the Service Catalog User Selections are 
now being enforced. 

40965 Stathistory records do not reflect the correct 
number of module licenses in use. For some 
modules, the count is always one, even if 
multiple licenses are in use.  

The stathistory records now reflect the correct 
number of module licenses in use. 

41115 The RAD application ‘calendar.calc.date.neg’ 
does not include holidays in the date 
calculation. 

Updated the ‘do.partial.week’ panel, so that 
the array of holidays is not cleaned up if the 
holiday is in the middle of the week. 

41753 Having the same approval group with the 
same condition generates an unrecoverable 
error. 

Modified the approval.generate application; 
the process.description and check.use.role 
panels; and the ScriptLibrary file. The 
Approval function process.description now 
properly handles cases where there are 
multiple approval entries with the same 
approver and sequence, and they evaluate to 
true. If that happens, the approval is 
generated, based on first match. 

41776 Inbox columns are not sorting. Button ID has been set correctly to 1000 so 
that the columns now sort properly for 
Inboxes. 

41950 Templates do not work for arrays that contain 
list data, as the array elements are 
concatenated. 

Array elements are no longer concatenated, so 
templates and fields are populated correctly. 

42153 Duplicate schedule records are being created 
for locked rescheduled alerts, with one 
schedule record referencing another alert that 
does not exist. 

Alerts are now properly rebuilt when there is 
a lock on the record being processed (a 
rescheduled alert). 
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SCR Problem Fix 

42218 If two users access the same record and one 
modifies it such that the category or phase is 
changed and then exits the record, the other 
user receives a message to the effect that “the 
record has been modified since you loaded it.” 
When the record is reloaded, it refreshes the 
data, except for the phase and category 
variables.  

When a record is reloaded, the phase and 
category variables are updated along with the 
rest of the data. 

42237 When the ‘alert.reset’ and ‘alert.recalc’ 
conditions in the Object record are set to 
expressions which involve NULL fields, they 
are not processed correctly. 

When conditions in the Object record are set 
to expressions which involve NULL fields, the 
value is correctly set to ‘false’ to avoid 
scheduling alerts that should not be 
scheduled. 

42238 Alerts do not get recalculated if the 
‘alert.recalc’ condition in the Object record is 
set to an expression. 

When the ‘alert.recalc’ is an expression 
instead of a logical value, the expression is 
evaluated first, and then compared to the 
result. 

42455 When sending out a message that is an array, 
the message text is not correctly broadcast 
onscreen. 

Changed the text parameter value of 
$MSG.TX with str($MSG>TX). 

42505 Records cannot be updated by any background 
processes when Folder Entitlement is enabled.

The linker process can now update records 
correctly in the background when Folder 
Entitlement is enabled. 

42925 Users with IDs that begin with SM are not 
logged out after they reach their inactivity 
time limit. 

Users with IDs that start with SM are now 
logged out after they reach their inactivity 
time limit. 

43011 System provides unprivileged access to some 
of the applications, such as Forms Designer, 
Links, and Format Control. 

Prevents users with EditContacts capability 
from editing the command line or cap.exec 
capability words in their own operator record. 
Ensures that users with no rights to editing 
an interaction category or Forms Designer or 
updating CIs cannot do so. 

43020 Unauthorized users able to force an update of 
payment records. 

Unauthorized users no longer able to update 
payment records. Set the IO condition in the 
payment.view display record to 
update.payment in the $G.ct.environment. 

43024 If an update event comes in with missing 
data, Format Control takes the bad validation 
path and ends up calling Format Control 
again, causing a loop.  The issue results in an 
infinite loop, which causes not only these 
external products to stop working but also 
Service Manager as resources continue to be 
consumed to the point where the system 
hangs and the server needs to be stopped.  

Fixed code, including changing the exit for 
failed validation to bad.validation.activity. 
Now when an event is updated with missing 
data, Format Control exits properly.  
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SCR Problem Fix 

43193 Customer and HP product teams’ feedback 
determined that we need to change the out-of-
box tailoring script to use the host name, 
network name, or service name as the 
primary identifier of a configuration item (CI). 

Both the logical.name and id fields are now 
populated with the CI name, machine name, 
or network name passed in from the UCMDB 
(depending on the CI type). 

Documentation 

The following items (identified by Software Change Request number) are fixed in the current software release. 

SCR Problem Fix 

29788 Sqldirect is not documented well. There is 
additional detail in a knowledgebase article 
which makes it much clearer. IT also 
includes information that this parameter is 
only applicable on a Windows server. 

The Help topic, SQL parameters: sqldirect, 
updated with the information in the knowledge 
article. 

36339 Update path in Help topic “How do I view 
software installation information?” 

Updated topic title to “View software installation 
information” and updated two paths within the 
topic to view configuration items and to manage 
software. 

36924 The Help topic “Console View” incorrectly 
states that the console view displays the 
sc.log file. It should state that it displays 
the sm.log file.  

The topic “Console View” has been corrected to 
state that in order to specify the sm.log file, go to 
Window > Preferences > Service Manager > 
Logs. 

37797 Approval type of “All must approve” is 
going to an Approved status as soon as a 
single user Approves the Change. 

Updated the topic “Approval actions” by 
modifying the definition of “All must approve” 
along with some minor changes throughout the 
topic. The definition for “All must approve” was 
correctly updated, as follows: All 
Groups/Operators defined in the Approval 
Definition must issue an approval before the 
status of the record is set to “approved.” If only 
one or some (but not all) of the Groups/Operators 
issues an approval, then the status of the record 
is set to “pending.” 

38391 Document Input and Output conversion 
mask for Forms Designer. 

The Mask field in Forms Designer has been 
clearly documented with an added example in 
the following topics: “Control: Comfill,” “Control: 
Date,” “Control: Decimal,” “Control: Table 
column,” and “Control: Text.” 

39480 Modify the Service Manager Installation 
Guide to note that the ulimit adjustments 
may also apply to HP-UX and Solaris 
environments. 

Updated the Server Installation chapter of the 
Service Manager installation guide for the HP-
UX, Linux, and Solaris servers to state that the 
upper limit (ulimit-n) is at least 1024. 

40935 Document a new Help topic for the new 
method called “insertBefore ().” 

The Help topic “JavaScript method: 
xmlDoc.insertBefore()” has been created, as this 
is a new method called to the XML object that is 
exposed in our JavaScript support. 
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40988 The topic titled “Configuring a horizontal 
scaling environment” spells loadBalancer 
incorrectly (all lowercase). The letter “B” 
should be uppercase. 

The topic titled “Configuring a horizontal scaling 
environment” now correctly states the proper 
spelling of the loadBalancer parameter.  

41145 Write necessary documentation for 
lightweight single sign-on (LWSSO) in the 
Service Manager Web client for BAC 
integration. 

Updated the Help topic “Example: Using 
LightweightSSO as an authentication source for 
trusted sign-on.” Added and updated the 
following: Added web.xml instructions to the 
LightweightSSO example and updated 
instructions to use <domain>example.com 
</domain> and to enable the <filter –mapping> 
element.  

41818 Update documentation for Connection 
timeout parameters, which no longer have 
an effect in the new Java implementation.  

In the JavaScript function Help topic 
“doHTTPRequest,” the timeout parameters 
described no longer have an effect, so have been 
removed from this Help topic. 

42096 Document new option to isolate a servlet 
node, using –debugnode:1 as the same 
option. 

Updated the parameter topic “debugnode.” 

42109 Need to document new parameter: 
maxKeepAliveRequests. 

Documented the new parameter in the Help as a 
new topic titled “Startup parameter: 
maxKeepAliveRequests.” 

42354 Document new parameter: 
preferredFQHN. 

Documented the new parameter in the Help as a 
new topic titled: “Parameter: preferredFQHN.” 

42397 Document new function parse_evaluate(). Documented the following Help topics: “RAD 
function: parse_evaluate()” and “JavaScript 
function: parse_evaluate().” 

 

RTE 

The following items (identified by Software Change Request number) are fixed in the current software release. 

SCR Problem Fix 

36472 Catalog images are not displayed by the 
client when the filename in the 
SYSATTACHMENTS record is not a valid 
file name. 

Catalog images are now displayed by the client 
when the filename in the SYSATTACHMENTS 
record is not a valid filename. 

37024 A view that displays a column with 
encrypted data (via data policy) does not 
decrypt the data. The encrypted data is 
displayed. 

The view that displays a column with encrypted 
data now properly decrypts the data before 
displaying it. 

38102 A process could terminate abnormally and 
not release the “system” semaphore. 

Fixed module lk.cpp and struct.h, so that a 
process no longer terminates abnormally and a 
“system” semaphore can be released. 

38751 Service Manager SST client is holding 
locks on calls when exiting the screen with 
the navigator while updating a ticket. 

Locks no longer occur when the client exits the 
screen with navigator while updating a ticket. 
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SCR Problem Fix 

40192 The scdb.system record is not removed 
when a fully converted system is stopped 
using the smstop command. 

The smstop command has been rewritten. Added 
documentation to explain the new command ‘sm 
–shutdown –group.’ Also added a note to the 
‘smstop’ command documentation regarding 
operating in a horizontally-scaled environment 
vs. a vertically-scaled environment. 

40318 Sort on QBE very slow. Improved performance of sorting in non-
recordlist mode by avoiding the reposition to the 
record that had the focus before the sort. After a 
sort, the first record in the resulting list will be 
the current record. 

41106 Service Manager 7.x Eventin records are 
not adding the attachments target ticket. 

Records processed through the eventin file (such 
as, Connect It) will now correctly associate any 
provided attachment data with the modified 
record. 

41556 Web Services do not work, if called from a 
background scheduler that is started via 
sm system.start. 

Set the same classpath for servlet mode and 
background, so that the Web Services now work 
when called from a background scheduler that is 
started via sm system.start. 

41815 When the server no longer has a valid 
connection to the Windows client but still 
tries to send it an ‘out of band’ message, 
the session does not terminate and cannot 
be ended. 

Fixed so that the client shutdown completes on 
the client session, and the client session 
terminates. 

41816 The –load parameter is P4-related and 
should be removed. 

The obsolete –load parameter has been removed. 

41915 Calendar button disappears when an 
invalid date/time value is entered into a 
date field that is not displayed by a date 
widget. 

Updated the Field type so that whether a date or 
time value is entered, the Calendar button will 
no longer disappear. 

41340 Wildcard searching (using %) is not 
working with a Fill query. 

Restored the ability to use wildcard characters 
during a “Find/Fill” query. 

41924 The sc.alert .log does not contain time 
stamps on the head of messages. 

Added time stamps, pid, and threadid 
information on the head of messages in the 
sc.alert.log file. 

41946 The reportlic count produces an error in 
Configuration Management. 

Do not use Configuration Management to count 
users. Instead, append a line to display the login 
licenses when using the reportlic parameter. 

41995 Problem displaying a list of incidents in 
Employee Self Service (ESS) mode when 
‘New thread: Search > List” is enabled. 

Displaying a list of incidents in Employee Self 
Service (ESS) mode is no longer a problem. 

42071 Copy function does not work when using 
related objects. 

Completed the logic in the adhocInsert function, 
so that the Copy function now works properly 
when using related objects. 
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SCR Problem Fix 

42109 Persistent Web Services are encountering a 
Tomcat timeout. 

Implement new parameter  
‘maxKeepAliveRequests:n’ to override the 
Tomcat limit of 100 processed requests per 
connection. 

42121 The Uncompress function causes an error 
when used in JavaScript. 

Added functions, so that the Uncompress 
function no longer causes an error when used in 
JavaScript. 

42138 Trusted sign-on should not require the 
creation or purchase of SSL certificates. 

SSL and SSO are now an optional component of 
a trusted sign-on implementation. Service 
Manger server now has an option to set up 
trusted sign-on independently. 

42139 Performance concerns with SELECT on 
inbox queries due to use of the new 
adhocsql feature in 7.0. 

When using the multi-table display feature of 
views, the SELECT statements generated for the 
secondary tables will no longer be SELECT, but 
instead will only select the required columns. 

42206 Messages with the phrase “Huh?” may 
appear in the log or in a dialog box when 
performing a check. 

Messages with the phrase “Huh?” no longer 
appear in the log or in a dialog box. 

42348 The debughttp output in the sm.log 
contains only the request document and 
not the response document. 

The XML response document will now be written 
to the log file when running the parameter 
‘debughttp.’ This is a debugging enhancement 
and does not impact normal logging. 

42354 Service Manger load balancer only honors 
one (default) I/O channel. 

Added new parameter ‘preferredFQHN’ that 
allows the user to set the fully qualified host 
name to be used by the load balancer for request 
redirection. This is useful on machines that have 
multiple host names. For example, in the sm.ini 
file ‘preferredFQHN:prodhost.emea.corp.net’ 
would cause the load balancer to send a redirect 
request back to the client with the given host 
name. This new parameter has been documented 
in the Help. 

42357 Application module licensing does not work 
correctly in a horizontally scaled system. 
The counts become inaccurate. 

Application license information is now correct in 
a horizontally scaled system. 

42396 Session may GPF when the server is 
adding or removing a session message, 
such as a message displayed to the user. 

The server now obtains the appropriate lock 
before adding a message to another session 
message queue. 

42397 The parse() and evaluate() function does 
not work in JavaScript. 

Added the parse_and_evaluate function to 
JavaScript. Created and updated the following 
Help topics: “Using RAD functions in 
JavaScript,” “JavaScript function: 
parse_evaluate(),” and “RAD function: 
parse.evaluate().” 

42438 Employee Self Service (ESS) buttons are 
not dynamically resized to accommodate 
their labels. 

Fixed for all ESS buttons, which cannot be 
designed in Forms Designer. Buttons will extend 
flexibly, depending on the button text length. 
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SCR Problem Fix 

42492 When an array field is mapped as multi-
row array while making multiple updates, 
the system continually adds spaces or tabs 
to previous updates if one line of text 
exceeds the mapping limit. This problem 
only occurs when the field is updated 
programmatically, not directly through the 
user interface. 

The server now correctly splits text for the 
mapping without inserting additional spaces or 
tabs. 

42557 The SCAuto listener process continually 
issues ‘debug’ type messages to the log file. 

The SCAuto listener process will no longer issue 
debug messages to the log, unless the 
debugscauto parameter was specified. A sample 
message might look like: process received: 
CONNECT,SCAuto_test,12690,all 

42590 When Service Manger performs a 
JavaScript doSOAPRequest() function, a 
java.lang.OutOfMemoryError: Java heap 
space error may occur. 

Prevents a java.lang.OutOfMemoryError: Java 
heap space error when executing the JavaScript 
doSOAPRequest() function. 

42611 Using IR Expert in a horizontally scaled 
mode does not update all the shared 
memories on all the hosts. They then get 
out of sync with the database and 
eventually corrupt the index. 

Implemented a cache clean request framework 
for IRQUEUE to make other nodes flush out-of-
date shared memory data structures. 

42656 Extend RAD function sysinfo.get() to 
return the server language that is used for 
the localized forms. 

Corrected code so that the RAD function 
sysinfo.get() value obtains the localized forms 
and messages. Also, created a new online Help 
topic “RAD function: sysinfo.get(“language”)” to 
explain the new RAD function 
“sysinfo.get(“languagecode”)” that returns the 
language code value for the server session. This 
is the value used to obtain the localized forms 
and messages. 

42692 SCAuto listener connections fail after some 
time of working correctly. 

Corrected code to fix the file handle leak in 
SCAuto server process. 

42693 The server leaks 12 bytes of memory for 
every SCAuto request that is processed. 

The memory leak has been correct in the SCAuto 
server process, so that SCAuto requests no 
longer leak memory when processed. 

42801 A memory leak is reported when looking at 
the processes and locks on the status panel. 
The memory leak occurs in a Horizontal 
Scaling implementation only, when there 
are at least two hosts. 

There are no more Java Heap Space issues 
reported when looking at the processes and locks 
on the status panel for a Horizontal Scaling 
implementation with at least two hosts. 

42831 The SCAuto application scsmtp hangs 
periodically when processing eventout 
records. This issue is most prevalent on 
Linux. 

The Service Manager server will now correctly 
send the entire enventout record to the calling 
SCAuto application without causing it to hang. 
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SCR Problem Fix 

42902 When updating an existing record with an 
attachment through the Web Service API, 
a new attachment was added to the record 
instead of replacing the existing one with 
the new attachment. 

The existing attachment is now replaced by the 
new attachment. 

42905 The system unload does not unload the 
language files. 

The system unload now properly unloads the 
language files. 

42926 There is a memory leak when processing 
the WSDL request for eventin. 

Code corrected so that there is no memory leaks 
when processing the WSDL request for eventin. 

43013 Web Services sessions through Service 
Manager Load Balancer are not cleaned 
properly from the Service Manager Load 
Balancer status report. If SSL mode is 
enabled on the server or the HTTP 307 
redirect is not fully compliant with the Web 
Services specification, Web Services (such 
as, Microsoft Biz Talk) cannot connect 
through the Service Manager Load 
Balancer. If either is the case, then they 
must connect directly through one of the 
Service Manager processes. 

Corrected code so that Web Services sessions 
through Service Manager Load Balancer are now 
fully compliant with the Web Services 
specification and are now properly cleaned from 
the Service Manager Load Balancer status 
report. 

43226 The counters/numbers transaction is not 
working correctly on a DB2 in a 
horizontally scaled environment, resulting 
in the following error message: “Record 
modified since read.” 

The DB2 statement handle release is delayed 
until a COMMIT is issued, which keeps the 
associated UPDATE lock intact. 

Web Client 

The following items (identified by Software Change Request number) are fixed in the current software release. 

SCR Problem Fix 

39722 With SSO enabled, failed logins result in 
displaying an empty framework. 

A new jsp has been added to the Web client, so 
that if the login fails when SSO is enabled, the 
user is now presented with a screen that 
displays the following message: “Authentication 
failed. Contact your system administrator for 
assistance.” 

Note: When a user’s credentials fail, a login 
screen is not displayed to avoid multiple tries for 
a failed login. 

40051  Decimal widget in the web client allows 
input of non-numeric values. 

Decimal widget in the web client now checks for 
the input of non-numeric values.  

40825 The Visible Condition for group object does 
not work in either the Web client or 
Windows client. 

The Visible Condition for group object now 
works correctly for the Web client and Windows 
client. 

40979 The text in the message dialog is not 
localized. 

The text in the message dialog can now be 
localized. 
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SCR Problem Fix 

41057 System Navigator and the Add File option 
appear in English on an English Operating 
System (OS) when logged in as Brazilian 
Portuguese or Simplified Chinese on the 
web client. 

System Navigator and the Add File option now 
correctly appear on an English Operating 
System (OS) when logged in as Brazilian 
Portuguese or Simplified Chinese on the web 
client. 

41171 On the web client, data in the first row of 
read-only columns is copied to new rows 
when new data is entered. 

For the Web client, data in the first row of read-
only columns is no longer copied to new rows 
when new data is entered. 

41278 A web client connection sends in the IP 
address of the web tier, which can cause a 
license problem on an installation with 
multiple web tiers. 

The license problem has been resolved. The web 
client IP address is now used instead of the web 
tier server IP address. 

41635 The height of the HTML Viewer, HTML 
Editor, and Text Area components in the 
web client is too small, resulting in gaps in 
the form. 

The height of the HTML Viewer, HTML Editor, 
and Text Area components in the web client is 
now calculated correctly. 

41646 Web client displays the function key 
buttons that do not exist on the keyboard. 

Nonexistent function keys no longer display in 
the Web client. 

41660 Repeatedly clicking QBE groups causes 
problems. For example, click to expand 
Priority 1 incidents, then click to expand 
Priority 2 incidents before the Priority 1 
incidents opens, and then wait. Nothing 
happens. 

Corrected code so that QBE groups open 
regardless of how quickly and repeatedly they 
are clicked. 

41725 When the caption text of a link label is 
long, it overflows the boundary of the link 
label. 

The caption text of a link label now displays 
within the boundary of the link label. 

41738 Using the applications print function in 
Internet Explorer 7 on the web client 
produces a printout with a tiny font size. 

Fixed so that using the applications print 
function in Internet Explorer 7 on the web client 
now opens a separate window, which displays 
the contents in a larger font size and allows the 
user to browse the contents. 

41885 When trying to enter a value in a Combo 
Box which contains a value list and also 
has the capability to allow you to enter a 
certain value, the web tier client does not 
allow the value to be entered and instead 
automatically finishes the selection. 

A Combo Box populated with a value list and 
which also has the capability to allow a user to 
enter a certain value will now allow the user to 
enter any value. 

42023 The Print function in the Web client uses 
more paper than necessary when using 
Microsoft Internet Explorer 7. 

The Print function in the Web client now uses 
the correct amount of paper when using 
Microsoft Internet Explorer 7. 

42075 Column width percentage of QBE forms in 
the Web client does not work as designed. 

Correct code so that the column width 
percentage of QBE forms displays correctly in 
the Web client. If the total width percentage of 
all visible columns is less than 100%, then the 
last column is extended to occupy the remaining 
space. 
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SCR Problem Fix 

42160 Cannot explicitly set Focus via Tailoring on 
a field that is displayed on the web client 
via a virtual join. 

Fixed so that Focus can be explicitly set via 
Tailoring on a field that is displayed on the web 
client via a virtual join. 

42165 Tables do not display correctly in the web 
client. The data in the first row of read-only 
columns is copied to new rows when new 
data is entered. 

Fixed so that data in the first row of read-only 
columns in tables is no longer copied to new 
rows when new data is entered. 

42227 Cannot deploy in a Websphere Common 
Environment. The .EAR files are not 
distributed with Service Manager. 

Distributed an .EAR file, which can be deployed 
in a Websphere Common Environment. 

42231 In the web client, the svc.options field is set 
to NULL after updating a Quote if the 
Dynamic Form widget that holds the 
svc.options field is set to Read Only. 

The svc.options field will not be set to Null after 
updating a Quote even if the Dynamic Form 
widget is set to Read Only. 

42383 The text directly input from a URL is not 
sanitized before being written back to the 
page. 

Corrected code so that any input from a URL 
into HTML entities is encoded to eliminate the 
cross-site vulnerability. 

42386 The NavMenuServlet has a cross-site 
scripting vulnerability. 

The NavMenuServlet cross-site scripting 
vulnerability has been cleaned up. 

42436 Multi-line entries ending with a carriage 
return in the ocmq description field are 
incorrectly built when saving a record. 

Multi-line entries ending with a carriage return 
in the ocmq description field are now correctly 
built when saving a record. 

42865 Out of memory errors occurred with Web 
tier running on Websphere. 

The Web tier now recognizes these messages, 
terminates the timer thread, and invalidates the 
session, resulting in proper cleanup. The 
“session-timeout” Web parameter value has 
been lowered to 15 minutes. However, it is best 
practice to set the “session-timeout” Web 
parameter value to 2 minutes, if you experience 
Service Manager Web client sessions lingering 
for longer than expected. 

Windows Client 

The following items (identified by Software Change Request number) are fixed in the current software release. 

SCR Problem Fix 

36615 Dashboards are not being retained when 
switching from one connection to another, or 
when logging off. 

Dashboards are now maintained globally, so 
when a user switches from one connection to 
another or logs off, the Dashboard states are 
retained. 

37469 When using the Windows client on a Japanese 
operating system with language packs, 
exporting a record to an Excel spreadsheet 
displays corrupted characters in Japanese. 

Corrected code so that files can be exported 
to csv instead of dde for Excel spreadsheets. 
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SCR Problem Fix 

38407 If a user clicks too fast when choosing a record 
from a QBE list while doing a recursive fill, the 
client displays the "Unrecoverable error 
refreshing screen" message. 

Code changed so that if a user clicks too fast 
when choosing a record from a QBE list 
while doing a recursive fill, the client no 
longer crashes and does not display an error 
message. 

39732 The Web client properly displays images in the 
table column regardless of the column’s 
position in the table. The Windows client can 
display images in a table column, except for 
the first column of a record list table. 

This is a known limitation of the Windows 
client. 

39774 The Service Manager application does not 
restore from minimized status. 

The Windows client now displays on top of 
other applications, as expected, when you 
use the DDE CTI interface to populate 
records in Service Manager. 

40301 An internationalization/localization issue 
where a Configuration Item (CI) does not 
display in the relationship graph under the 
upstream CI that has a non-ASCII CI name. 

Transform a non-ASCII name from UTF16 
into UTF8 for internal use, and then UTF8 
back into UTF16 for external query. 

41040 Accessing SYSATTACHMENTS in the System 
Definition menu generates an error (Invalid 
byte 2 of 3-byte UTF-8 sequence). 

The ability to drill down into individual 
records in the System Definition menu has 
been removed. 

41640 The Windows client suddenly starts processing 
Data Changed Event of 0. When this occurs, 
the cursor jumps back to the callback.contact 
field on our SD.open.interaction format after 
every character has been entered into the 
category, subcategory, product.type, or 
problem.type field. 

The Data Change Event no longer sets to 0 
instead of NULL when clearing out the Data 
Change Event. The cursor no longer jumps. 

41694 Shortcut to magnify a scrollable text field in 
Service Manager is not working. 

Shortcut to magnify text in a scrollable text 
field has been changed from Ctrl+M to 
Ctrl+Shift+M to allow users to expand a 
scrollable text field by opening a separate 
window that magnifies the text for easier 
viewing and editing. The Help topic “List: 
Windows client keyboard shortcuts” has been 
updated to include the Ctrl+Shift+M 
keyboard shortcut. 

41707 When saving the info.startup.g form without 
doing anything, only the first record displays. 

Code corrected so that when a user clicks 
save on the info.startup.g form without 
making any changes on the form all of the 
records now displays correctly. 

41754 Clicking the plus sign for 
SYSATTACHMENTS or the code table in the 
system definition utility causes the client to 
fail. 

Problem fixed, so that queries no longer 
include columns that store binary data. 

41767 The Favorites record count is incorrect. The Favorites record count now works as 
expected, and there is a slight improvement 
in system performance. 
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SCR Problem Fix 

41843 QBE lists containing array fields do not 
display the entire array contents. 

QBE lists containing array fields now show 
the entire contents of the array fields. 

41850 Adding an attachment only to a record with no 
other changes does not trigger the record as 
modified. When I click Back, there is no 
prompt to save the record.  

Adding an attachment only to a record does 
not trigger the record as modified. However, 
you can now click Back to be prompted to 
save the record with no problem. 

41890 Error occurs when attempting to view a Label 
type field while using System Definition.  

A Label type field can now be viewed without 
introducing any errors. 

41910 Default focus is only set on the first format 
when displaying multiple formats in a dialog. 

Default focus is now set properly in all 
formats when displaying multiple formats in 
a dialog. 

41916 Text does not wrap in multi-line text fields on 
dynamic forms. 

Changed code to add the Wrap attribute to 
the text widget. 

41953 The Escape key causes the Save prompt to lose 
data when changing records via the Database 
Manager search. 

The Escape key no longer causes the Save 
prompt to lose data when changing records 
via the Database Manager search. 

41960 On Windows, the dynamic view dependencies 
(DVD) conditions are not immediately honored 
when they are based on an array field. If a 
field has a DVD condition that is based on an 
array, the property does not immediately take 
effect when you modify the array to satisfy the 
condition, A screen refresh is required for it to 
occur. 

This has been fixed so that the screen refresh 
is no longer required to satisfy the DVD 
condition. For example, if you modified the 
“IM.open.incident” format in Forms Designer 
so that the “CI is operational (no outage)” 
checkbox (input “operational.device”) has a 
Visible Condition of: [action]<>, you no 
longer have to refresh the screen in order for 
the checkbox to be visible. 

41996 Windows client does not respond correctly to a 
font increase with timer. 

A font increase change works with the XML 
Time widget. 

42059 The maximum characters property is not 
enforced on comfill (the combination Combo 
Box and Fill button) objects.  

The maximum characters property is now 
correctly enforced on comfill and combo 
objects. 

42081 The Caption Condition property for combo 
boxes/comfills does not utilize the Display List 
property on the Windows client. 

The Caption Condition property for combo 
boxes/comfills now utilizes the Display List 
property on the Windows client. 

42183 Creation of the default connection in the 
Windows client Configuration Utility does not 
work since rebranding of the application. 

The code creating the default connection file 
now uses the correct application package 
name. 

42579 Clicking links in the HTML Viewer locks the 
record rather than navigating to the link. 

The client no longer sends the Form Modified 
event when building the link request. 
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Known Problems, Limitations, and Workarounds 

This software release has the following known issues. 

 

Document 
ID  

Known Issue  Workaround  

KM542605R 
 

The KMUpdate process (that indexes 
documents) automatically starts with the 
SM7 system start. Since the Knowledge 
Management environment is not 
configured at that point, the KMUpdate 
process will not work. An error message 
appears in the KMUpdate Schedule, and 
the Class field is cleared. Once the 
environment is configured correctly, the 
KMUpdate process fails because the Class 
field is blank. 

The KMAdmin ScriptLibrary code now checks 
periodically to see if the system is configured, 
and then begins execution when the system is 
configured. For additional information, see 
knowledge article KM542605R. 

KM744287 
 

Attempting to import a dbdict from an 
existing table with varchar(max) and 
varbinary(max) produces dbdict entries of 
varchar(0) and varbinary(0). After they 
are imported, you can change them 
manually to the correct mappings, but 
this causes a duplicate key error and the 
file is locked, which prevents further 
manipulation. At this time, Service 
Manager does not support the 
varchar(max) and varbinary(max) data 
types offered by Microsoft SQL Server. 

Use the data type image and text when Service 
Manger runs against a SQL Server instance. 

KM743658 

 

Background file loads of .unl files do not 
take into account the merging of records 
and SQL maps. This means that when 
you load records in the background the 
dbdict load options are not used. All 
unloads are treated as if the dbdict load 
option "Create file if not there, but do 
NOT update if present" was selected even 
if one of the other options was used. 

When loading an unload file that requires an 
update of the dbdict, including changes to SQL 
mapping, use the foreground load instead. 
 

 

KM628550 
 

Knowledge Management unable to index 
documents using a Service Manager 7.10 
server and 7.01 applications. 

1. Before installing the 7.10 server with the 
7.01 applications, make a copy of the 7.01 
server file RUNlibkmplugin-7.01.jar and save 
the copy in another folder. 
2. After installing the 7.10 server, rename the 
7.10 server file in the RUNlib directory from 
kmplugin-7.10.jar to kmplugin-
7.10.unused_with_7.01apps. Do not end the file 
with the extension .jar. 

3. Move the file copied file from step 1 to the 
7.10 server file RUNlib directory and rename 
the file kmplugin-7.10.jar. 
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Document 
ID  

Known Issue  Workaround  

KM634506 
 

Attachments are not showing correct file 
icons in the Windows client. Although you 
have registered the target applications in 
the Windows registry, it is impossible to 
find an icon for applications without a 
“DefaultIcon” key or Icon Handler in the 
Windows operating system. 

To add a default icon in the Windows registry:  
1. Enter HKEY_CLASSES_ROOT, and then 
find the .pdf. 
2. Under .pdf, find the default key, 
“AcroExch.Document.” 

3. Add a key called “DefaultIcon.” 
4. Assign the icon path for the “DefaultIcon” 
key. For example: C:\Program 
Files\....\adobereader.ico 
For detailed information on adding a default 
icon and creating Icon Handlers, see the 
Microsoft knowledge article “Creating Icon 
Handlers” at the following URL: 
http://msdn.microsoft.com/en-
us/library/bb776857.aspx . 

KM746175 

 

When opening a change and the user 
selects a CI Group as an affected CI, this 
CI group is treated as a normal CI. The 
change record is not aware of any member 
of the group and therefore when CI 
attributes are modified through its status 
workflow (proposed, planned, 
implemented, validated), those changes 
only apply to the CI group itself. Changes 
to attributes do not apply to any of the 
members of the group. 

No workaround available at this time. 

KM746898 

 

Various fields from the UCMDB are being 
truncated during replication to Service 
Manager database. 

The size for a field can be changed within 
Service Manager by updating the SQL Type 
definition within the dbdict.  For example, if 
VARCHAR(40) is not large enough this can be 
changed to VARCHAR(60) (or greater if need 
be) to accommodate the field size being 
replicated from the UCMDB system. 

KM743833 
 

When connecting to Web Services with 
the web header, "Accept-Encoding: gzip, 
deflate", can cause 3rd-party SOAP 
clients to hang. When Service Manager 
server responds to the Web Services 
Client in GZIP format, "Content-Length" 
value in HTTP Header is calculated 
before the message body is GZIP-ed. This 
causes some Web Services clients to 
expect more message data even if the full 
GZIP-ed message has been received.  

 

Change the Accept-Encoding header value 
from "gzip, deflate" to "text/xml". 
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Document 
ID  

Known Issue  Workaround  

KM744117 
 

An unrecoverable error occurs during an 
upgrade because the upgrade data is now 
distributed. In previous versions, all the 
data was contained in a single 
upgrade.dta file. The upgrade code now 
has this data exported to several .dta files 
by table within a data subdirectory. 

 

Create a data subfolder before performing an 
upgrade. 

KM744500 
 

When a kmdocument is saved after a link 
to a another kmdocument is added to it, 
this error appears in Messages:  
  Length (32 bytes) of data for field linkid 
in kmdocument exceeds max (30 bytes), 
truncated (se.base.method,update.record). 
The linkid field in the kmdocument table 
is too small, if it defined as VARCHAR. 

Since the 7.11 patch does not include changes 
to existing dbdict records, you need to 
manually increase the length of the 
kmdocument record's linkid field in the dbdict 
table from 30 to 80 bytes. 

 
1. Log on as an administrator. 
2. Type dbdict in the command line. 

3. Enter kmdocument as the File Name to 
modify. 

4. Scroll down to find the links field. The SQL 
type should be blank, not IMAGE. There's 
nothing to fix, if your dbdict shows that links is 
an IMAGE. 
5. If the SQL Type for links is blank and the 
SQL Type for linkid is VARCHAR(30), then 
double-click linkid and change the SQL Type 
from VARCHAR(30) to VARCHAR(80).  

6. Click OK twice to save the change. 
 

KM744530 

 

The RAD function translate() fails if the 
string  include multibyte characters. The 
RAD function translate() is ONLY valid 
for single-byte (ascii) characters.   

 

The recommended function to use for character 
replacement in double-byte character strings is 
"strrep" and not "translate".  If you want to use 
the functionality provided by translate() on 
multi-bytes characters (like umlauts or 
Chinese characters), you should instead use 
the RAD function strrep() to achieve the same 
result.  Example #1:   x $d="abâ€°Ë†Â¸cd"   
abâ€°Ë†Â¸cd    x $x=strrep($d,"â€°Ë†","ï¬‚")   
abï¬‚Â¸cd  Example #2:   x $d="abâ€°Ë†Â¸cd"   
abâ€°Ë†Â¸cd    x $x=strrep($d,"â€°Ë†","ï¬‚i")    
abï¬‚iÂ¸cd  For more information on this known 
issue, search the knowledgebase for document 
ID 2125445. 
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Document 
ID  

Known Issue  Workaround  

KM746903 
 

Move or Copy to box on Web Client 
Manage Favorites is not expanded. 

Manage Favorites fails to list the personal 
views that a user owns. The out-of-box user 
falcon owns all the views displayed above the 
"Move or Copy to" list. The personal views 
owned by the user are not displayed. Because 
only the owner of a favorite can change it, the 
list of views that a user other than falcon can 
Move or Copy is empty. Manage Favorites will 
be updated in a future release. 

KM744898 

 

When you add an affected CI within a 
change record, the form jumps 
immediately to the Associated CIs tab, 
because the “assets” (associated CIs) field 
is referenced in two controls on the form: 
One on the root of the form and the other 
in one of the notebook pages. The web 
client is restoring the right notebook page 
to set the focus properly, but it is only 
active if you have saved the record. In this 
case, you need to add an alias for the 
assets field and refer to the alias field. 

To create an alias field: 

1. Click Tailoring > Database Dictionary. 
2. Type “cm3r” in the File Name field. 
The cm3r table is displayed. 

3. Select the Fields tab and use the scroll bar 
on the Fields tab to scroll down to find and 
select the “assets” character type field. 

4. From the Options menu, select Edit 
Field/Key. 
The field window opens. 

5. Click Create Alias. 
6. In the Name field, type the name of the alias 
(for example, assets.alias), and then click OK. 
7. Go to Forms Designer to change the input 
from assets to assets.alias. 

 a. Click Tailoring > Forms Designer. 
 b. Type “CM.change.logging” in the Forms 
field, and then click Search. 

 c. Click Design. 
 d. Select “Affected CI” field comfill. 
 e. Change input from assets to assets.alias. 

 f. Click OK. 
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Document 
ID  

Known Issue  Workaround  

KM744965 
 

Service Catalog options are not appearing 
properly in changes opened to fulfill a 
catalog request. 

The information is going to be copied from the 
Options field in the svcCatalog table to the 
svc.options field in the cm3r table. The 
svc.options field needs to be properly mapped 
to hold HTML/XML type data. It is currently 
mapped to the wrong RDBMS type and is 
truncated, so it is not being handled properly. 

 
Change the cm3r dbdict field svc.options 
and map the RDBMS to change it from 
VARCHAR to IMAGE in Microsoft SQL Server 
(or equivalent for Oracle and DB2). 
  

1. Log on to Service Manger as a System 
Administrator. 
2. Click Tailoring > Database Dictionary. 

3. Enter cm3r in the File Name field, and then 
click Search. 

4. Using the scroll bar in the Fields tab, scroll 
down to and double-click on the svc.options 
character field.  
    The field.window opens. 
5. In the SQL Type field, change the SQL type 
to IMAGE for Microsoft SQL Server (or the 
applicable type for Oracle and DB2), and then 
click OK. 

6. Click OK again to exit the dbdict page. 
 

  

KM745260 
 

On a report that uses two tables that are 
linked, if the user selects a date range 
that has no associated data, the user 
receives an error message 'Failed to 
retrieve data from the database'.  

A query from two linked tables failed 
when an empty recordset was returned. 
Received the following error message: 
“Failed to retrieve data from the 
database.” 

The query from the two linked tables was 
translated to a query on a join table in 
Service Manager. However, when no 
recordset was returned, according to the 
query condition, the ODBC driver 
behavior was such that the user had 
issued a query to a non-existent table, 
which caused the Crystal Report error 
message to be sent to the user.  

Change the ODBC driver behavior so that 
when there is a query from two linked tables 
and there is no recordset returned, the ODBC 
driver returns an empty recordset. 
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Document 
ID  

Known Issue  Workaround  

KM745516 
 

The Template Service Catalog is missing. Load the unload file provided. 
1. Log on as System Administrator. 

2. Click Tailoring > Database Manager. 
3. From the Options menu, select 
Import/Load. 
4. Enter the File Name with the full path to 
the unload file. 

5. Click LoadFG to load the file. 

KM745526    

 

The Release Management Candidates 
view does not show up for change 
managers (Change.Manager operator). 
The Release Management Candidates 
view is restricted to System 
Administrator and Change Coordinator 
roles. 

Update the View to add the change manager 
role to the Audience tab. 
 

KM745567 
 

New images in the service catalog do not 
display. When you upload a new image 
from Service Catalog > Manage Catalog, 
the image uploaded is not displaying 
when you access the order from the 
service catalog. Instead, it displays the 
image from out-of-box (OOB) system. 
 

PART I: In "svcCat.display.catalog" Display 
Application, Main > Initializations tab, modify 
the following: 

 
FROM 
for $L.i = 1 to $L.show do (if (not null($L.i in 
$L.current.items.image)) then 
($L.temp="$L.image."+$L.i+"=\""+$L.i in 
$L.current.items.image+"\"");$L.void=evaluate
(parse($L.temp, 11))) 
 

TO 
for $L.i = 1 to $L.show do (if (not null($L.i in 
$L.current.items.image)) then 
($L.temp="$L.image."+$L.i+"=\""+strrep($L.i 
in $L.current.items.image, "svcCatalog;", 
"joinsvcDisplay;")+"\"");$L.void=evaluate(parse
($L.temp, 11))) 
 
PART II: This section applies if you are going 
to keep any of the out-of-box (OOB) images. 
 

1. Go to "SYSATTACHMENTS" db 
2. Select and modify the topics which you 
would like to keep the OOB images for (e.g. 
Application Access, Business and Department 
Services) 
 

KM745768 
 

On a Solaris platform, the Service 
Manager server generates a signal 11 
when the system has an out of date 
version of AutoPass. 

Before you start the Service Manager server on 
Solaris, install the current AutoPass license 
from the Service Manger DVD, which contains 
the current AutoPass license version 5.51. 
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Document 
ID  

Known Issue  Workaround  

KM745805 
 

When performing a mass update on 
Configuration Items after using the 
Search Specific Type feature, user may 
experience errors similar to the following: 
An error occurred while attempting to 
update a record 
(se.base.method,update.record) 

file:(joincomputer) 
key:(file.device,logical.name=adv-afr-
desk-102) (se.base.method,update.record) 

update terminated - could not access row 
id (se.base.method,update.record) 

The errors only occur when using the Search 
Specific Type feature, and there is an update 
against a record that does not have a joined 
(attribute) file record. The Search Specific Type 
feature is only necessary if searching for fields 
to mass update based on joined file (attribute) 
fields. The same operation works properly 
using the standard mass update. 
 

KM746023 

 

Performing a mass update of the model 
table using Templates causes system to 
hang 

Use the Simple or Complex update function 
which will not call the model format control 
record thus avoiding the loop which causes the 
system to hang. Do not use template updates. 

 

KM746131 
 

A user can view a KM document, but 
cannot add it as a link within another KM 
document. For example, a KCS I, II, or III 
user can link to documents that are in a 
category to which the user has rights to 
contribute and/or modify. However, if a 
user has only view privileges for the 
document, the following error occurs: 
"Invalid entry. You do not have view 
rights to the document with id XXXXXX". 

Also, when a user has permission to view 
an externally approved KM document in a 
search results list, the user cannot view 
the same document via a link in another 
document. The following error displays 
when the user attempts to view the 
document: 
"You do not have permission to view the 
knowledge document with id XXXXXX"  
 

Contact HP Customer Support for information 
on how to correct this problem. 

 

KM747139 

 

In the Web client, read-only combo boxes 
and comfills are rendered too narrow and 
don't align with other fields on the form. 
When combo boxes or comfills with a 
read-only DVD condition change from 
editable to read-only, they are rendered 
with the width originally defined in the 
Form Designer. They do not stretch with 
the form as do the other controls on the 
form. 

None available at this time. 
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Document 
ID  

Known Issue  Workaround  

KM747863 When creating or editing a dbdict using 
the dbdict utility and all columns are 
marked as inactive (mapped to 
“nulltable”) in the SQL Mapping, errors 
occur because the system incorrectly 
maps all columns as active and attempts 
to perform the corresponding backend 
database actions. 

Mapping all columns of a table as inactive 
(mapping to “nulltable”) is not possible at this 
time. 

KM747917 
 

SQL Error when creating Dashboard from 
Change by Configuration Item (CI). 
Creating a dashboard from Changes and 
Configuration Items will not work 
because columns in these two types are 
mapped to image data types in the SQL 
back end and RDBMS backends do not 
support sorting of these data types. 

None available at this time. 

KM747933 
 

The system allows a user to save a cloned 
interaction without escalating it to an 
incident or a change. The cloned 
interaction form has a Save button. 
 

This is a problem in the process flow of the 
clone operation. Users should avoid doing this, 
as it can cause workflow problems. 
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Document 
ID  

Known Issue  Workaround  

KM747931 Database performance is slow when you 
query Configuration Item (CI) 
relationships and there are more than 
1,000 relationships in the “cirelationship” 
table. 

To optimize database performance, map the 
“cirelationship” table as a multi-row array 
table. This solution works because the 
“cirelationship” table contains only two arrays, 
which are mapped as subtables 
“cirelationshipa1” and “cirelationshipa2.” 
 
Caution: This solution is not optimal or 
recommended for tables with more than a few 
arrays, such as the “cm3r” table which contains 
27 arrays. For example, mapping the “cm3r” 
table as a multi-row array table creates 28 
tables (cm3rm1 and cm3ra1 – cm3ra27). 
Selecting one record would result in 28 queries 
against the RDBMS, which would negatively 
impact database performance. 
 
To map the “cirelationship” table as a multi-
row array table: 
1. Log on as a System Administrator where 
only one HP Service Manager client listener is 
running. 
2. Click Tailoring > SQL Utilities >Move 
Files from SQL to SQL. 
3. Select the Basic Options tab. 
4. In the File to Convert field, select 
cirelationship from the list of files to convert. 
5. Select the Advanced Options tab. 
6. For the Dispositions of Arrays option, choose 
Multi Row Array Table. 
7. Click Proceed. 
A message appears, stating that moving data 
for the cirelationship file is finished. 
8. Click OK. 
A message appears, stating that the conversion 
of the cirelationship table is completed. 
9. Click Back. 
A message appears, stating that you will now 
log out. 
10. Click OK. 

KM747936 
 

Cannot add attachments (images) for the 
service catalog via Web Services. The 
system cannot create a joinsvcDisplay 
extaccess record because the query is not 
returning it in the list of files to select 
from the dropdown in the Name field. 

No workaround available at this time. 
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Document 
ID  

Known Issue  Workaround  

KM748084 Service Manager fails to import the 
catalog categories and catalog items from 
Asset Manager to Service Manager. 

Load the unload file, svcDisplay, which 
provides a new service called 
ServiceCatalogDisplay. The svcDisplay table 
holds all the localized data for a catalog item or 
category. The unique key is a compound of 
name and syslanguage. 
 
In addition to these changes a schema change 
is also be necessary in the svcDisplay dbdict.  
Follow these instructions to make the change: 

1. Go to the dbdict utility (dbdict from the 
command line or Menu Navigation-
>Tailoring->Database Dictionary) 
and enter svcDisplay for the file name. 

2. Click the descriptor which is the first 
line in the table. 

3. Click the descriptor which is the first 
line in the table. Click the New 
Field/Key button.  

4. Give the field a name of optionList, a 
type of character and click OK. 

5. In the table give optionList a SQL 
Name of OPTIONLIST, a type of 
IMAGE and a SQL Table of m1.  

6. Click the descriptor again and the New 
Field/Key button. 

7. Give the field a name of optionOptions, 
a type of Character and click OK. 

8. In the table give optionOptions a SQL 
Name of OPTIONOPTIONS, a type of 
IMAGE and a SQL Table of m1. 

9. Click OK. 
10. Click SM Alters. 

KM748154 Using a type of TIMESTAMP in a dbdict 
SQL mapping on an Oracle database 
causes soap faults and a signal 11 error 
when saving data into the column. Service 
Manager will not automatically choose 
this data type, but users are able to 
manually map a database field to a SQL 
type of TIMESTAMP. 

Do not use the data type of TIMESTAMP for 
an Oracle database in Service Manager 
mappings at this time. Use the type DATE 
instead. 
 
 

KM749356 The dbdict utility creates an invalid 
dbdict record when “Import SQL columns” 
does not return any new columns. The 
RAD dbdict.utility attempts to add 
imported new columns whether or not 
there are any new columns imported. 
Additionally, it writes data into the non-
existing columns array and pastes the 
entry to the end of the dbdict, adding an 
invalid entry. 

There is no workaround available at this time. 
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Installation Notes 

Instructions for installing Service Manager, are documented in the Installation Guide for HP Service 
Manager 7.11 provided in Adobe Reader (.pdf) format. The document file is included on the product's 
installation media. 

Verified Environments 

The Compatibility Matrix lists supported versions of operating systems, browsers, HP Software products, 
and other compatibility and support information.  

To access the Compatibility Matrix  

1 Use a browser to navigate to the Support Software Online (SSO) web page:  
http://support.openview.hp.com/sc/support_matrices.jsp 

2 Log on with your Customer ID and password or your HP Passport sign-in.  

3 Navigate to the applicable information.  
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Local Language Support 

UTF-8 is part of the Unicode standard, which enables you to encode text in practically any script and 
language. Service Manager 7.01 supports UTF-8 as an encoding method for new or existing data. It can 
support multiple languages that adhere to the Unicode standard on the same server. 

Support 

You can visit the HP Software support web site at: 

http://h20230.www2.hp.com/new_access_levels.jsp 

This web site provides contact information and details about the products, services, and support that HP 
Software offers.  

HP Software online software support provides customer self-solve capabilities. It provides a fast and efficient 
way to access interactive technical support tools needed to manage your business. As a valued support 
customer, you can benefit by using the support site to: 

 Search for knowledge documents of interest 

 Submit and track support cases and enhancement requests 

 Download software patches 

 Manage support contracts 

 Look up HP support contacts 

 Review information about available services 

 Enter into discussions with other software customers 

 Research and register for software training 

Most of the support areas require that you register as an HP Passport user and sign in. Many also require 
an active support contract. To find more information about support access levels, go to the following URL: 

http://h20230.www2.hp.com/new_access_levels.jsp 

To register for an HP Passport ID, go to the following URL: 

http://h20229.www2.hp.com/passport-registration.html 
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Legal Notices 

©Copyright 1994-2009 Hewlett-Packard Development Company, L.P. 

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent 
with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and 
Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard 
commercial license. 

The only warranties for HP products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an additional 
warranty. HP shall not be liable for technical or editorial errors or omissions contained herein. 

The information contained herein is subject to change without notice. 

This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This product includes software 
written by Tim Hudson (tjh@cryptsoft.com). Smack software copyright © Jive Software, 1998-2004. SVG Viewer, Mozilla 
JavaScript-C (SpiderMonkey), and Rhino software Copyright © 1998-2004 The Mozilla Organization. This product 
includes software developed by the OpenSSL Project for use in the OpenSSL toolkit. (http:// www.openssl.org). OpenSSL 
software copyright 1998-2005 The OpenSSL Project. All rights reserved. This project includes software developed by the 
MX4J project (http://mx4j.sourceforge.net). MX4J software copyright © 2001-2004 MX4J Team. All rights reserved. 
JFreeChart software © 2000-2004, Object Refinery Limited. All rights reserved. JDOM software copyright © 2000 Brett 
McLaughlin, Jason Hunter. All rights reserved. LDAP, OpenLDAP, and the Netscape Directory SDK Copyright © 1995-
2004 Sun Microsystems, Inc. Japanese Morphological Analyzer © 2004 Basis Technology Corp. The Sentry Spelling-
Checker Engine Copyright © 2000 Wintertree Software Inc. Spell Checker copyright © 1995-2004 Wintertree Software 
Inc. CoolMenu software copyright © 2001 Thomas Brattli. All rights reserved. Coroutine Software for Java owned by 
Neva Object Technology, Inc. and is protected by US and international copyright law. Crystal Reports Pro and Crystal 
RTE software © 2001 Crystal Decisions, Inc., All rights reserved. Eclipse software © Copyright 2000, 2004 IBM 
Corporation and others. All rights reserved. Copyright 2001-2004 Kiran Kaja and Robert A. van Engelen, Genivia Inc. 
All rights reserved. Xtree copyright 2004 Emil A. Eklund. This product includes software developed by the Indiana 
University Extreme! Lab (<http:// www.extreme.indiana.edu/>). Portions copyright © Daniel G. Hyans, 1998. cbg.editor 
Eclipse plugin copyright © 2002, Chris Grindstaff. Part of the software embedded in this product is gSOAP software. 
Portions created by gSOAP are copyright © 2001-2004 Robert A. van Engelen, Genivia Inc. All Rights Reserved. 
Copyright © 1991-2005 Unicode, Inc. All rights reserved. Distributed under the Terms of Use in http:// www.unicode.org/ 
copyright.html.  

For information about third-party license agreements, see the licenses directory on the product installation 
DVD (\redistributables\licenses).  

Java™ and all Java based trademarks and logos are trademarks or registered trademarks of Sun 
Microsystems, Inc. in the U.S. and other countries.  

Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation.  

Oracle® is a registered US trademark of Oracle Corporation, Redwood City, California.  

UNIX® is a registered trademark of The Open Group. 


